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BAB II

LANDASAN TEORI

2.1 Pengertian Akuntansi

Menurut Thomas Sumarsan (2020 : 1) menjelaskan bahwa : Akuntansi adalah

suatu seni untuk mengumpulkan, mengidentifikasikan, mengklasifikasikan, mencatat

transaksi serta kejadian yang berhubungan dengankeuangan, sihingga dapat

menghasilkan informasi yaitu laporan keuangan yangdapat digunakan oleh pihak-pihak

yang berkepentingan. Metode pencatatan, penggolongan, analisa dan pengendalian

transaksiserta kegiatan-kegiatan keuangan, kemudian melaporkan hasilnya.

Kegiatanakuntansi, diantaranya :

1. Pengidentifikasian dan pengukuran data yang relevan untuk suatau

pengambilankeputusan.

2. Pemrosesan data yang bersangkutan kemudian pelaporan informasi yang dihasilkan.

3. Pengkomunikasian informasi kepada pemakai laporan.

Winwin yadianti, Ilham Wahyudin (2020 : 6-7) Akuntansi adalah suatu sistem

informasi yang mengidentifikasi, mencatat, dan mengkomunikasikan kejadian ekonomi

dari suatu organisasi kepada pihak yang berkepentingan. Dari pengertian tersebut

terkandung kegiatan akuntasi yaitu :

1) Mengidentifikasi

Kejadian ekonomi berkaitan dengan aktivitas ekonomi yang relevan darisuatu oraganisasi

tertentu. Pembayaran utang, pembayaran pemebaliantunai, penjualan kredit adalah contoh

dari kejadian ekonomi tersebut.

2) Mencatat

Secara historis aktivitas keuangan organisasi. Pencatatan dilakukan secarasistematis,

berurutan sesuai kronologi kejadian dan harus dapat diukur dalam satuan moneter. Dalam

proses pencatatan ini, kejadian ekonomikemudian diklasifikasikan dan diringkas
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3) Mengkomunikasikan

Kejadian ekonomi kepada pihak yang berkepentingan dalam bentu laporan keuangan

yang memuat informasi keuangan organisasi yang dapatdijadikan dasar dalam

pengambilan keputusan.

Berdasarkan beberapa definisi diatas, dapat disimpulkan bahwa akuntansi

adalah :

1. Suatu alat untuk mengukur hasil kegiatan ekonomi perusahaan sehingga

dapat memberikan keputusan yang tepat terhadap perusahaan dapat

berjalan normal.

2. Suatu proses untuk menyediakan informasi mengenai pencatatan hingga

pelaporan informasi ekonomi sesuai dengan standar yang berlaku untuk

digunakan oleh pemangku kepentingan.

Defenisi Akuntansi menurut Weygan, Kimmel dan Kieso (2018:3)

menyatakan bahwa akuntansi adalah sistem informasi yang mengidentifikasi,

merekam, dan mengkomunikasikan kegiatan ekonomi pada organisasi kepada

pengguna yang berkepentingan.

Menurut Warren el al (2017) menjelaskan persamaan dasar akuntansi

merupakan dasar sistem akuntansi semua perusahaan. Persamaan ini mengukur

sumber daya perusahaan (Aset) dan klaim atas sumber daya tersebut (liabilitas +

ekuitas) .

Aset = Liabilitas + Ekuitas

1. Aset adalah sumber daya yang dimiliki oleh perusahaan, yang nantinya

akan menjalankan kegiatan bisnis/ operasional sehari-hari. contohnya kas,
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2. Piutang usaha, persediaan, sewa dibayar dimuka, aset tetap,

perlengkapan,dll.

3. Liabilitas (Kewajiban) adalah hak, klaim, nastutan kreditor terhadap aset

perusahaan yang harus dibayarkan pada saat jatuh tempo. contohnya utang

usaha, pinjaman bank, utang gaji (upah), kewajiban garansi.

4. Ekuitas (Modal) adalah hak, klaim, nantutan pemilik dana ( pemegang

saham) atas aset yang dimiliki perusahaan sehingga dikurangi dengan

seluruh liabilitas harus di tempatkan lebih dahulu sebelum equity, ini

mengandung makna bahwa kreditor memiliki hak yang pertama atas

kekayaan perusahaan, setelah itu sisa aset yang masih ada barulah

merupakan hak pemilik dana ( pemegang saham)

2.2 Siklus Dasar Akuntansi

Menurut (Rudianto 2020) Siklus akuntansi adalah aktivitas

mengumpulkan, menganalisis, menyajikan dalam bentuk angka,

mengklasifikasikan, mencatat, meringkas dan melaporkan aktivitas/transaksi

perusahaan dalam bentuk informasi keuangan.

Jika digambarkan dalam bagan arus, tahapan siklus akuntansi akan Nampak

sebagai berikut :

Gambar : 2.1 Siklus Akuntansi

Sumber: Pengantar Akuntansi 1 ( Warren et,al 2017)
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2.2.1 Identifikasi Peristiwa dan Pencatatan Transaksi

Dalam (Satria and Fatmawati 2021) “Transaksi adalah kejadian atau

situasi yang mempengaruhi posisi keuangan suatu perusahaan”. Sedangkan

menurut Suradadi (2020:24) “Transaksi bisnis atau transaksi keuangan adalah

suatu kejadian atau peristiwa ekonomi yang dicatat dan berpengaruh pada hasil

operasi atau kondisi keuangan perusahaan”.

Berdasarkan pengertian diatas, dapat disimpulkan bahwa pencatatan

transaksi dilakukan apabila transaksi tersebut berpengaruh langsung terhadap

kondisi keuangan suatu perusahaan.

2.2.2 Jurnal

Jurnal menurut (Bahri, Dkk 2020 ) adalah pencatatan sistematis

dankronologis atas transaksi keuangan entitas. Jurnal merupakan langkah awal

dalam siklus akuntansi. Jurnal berbentuk kolom-kolom yang berisi tanggal, nama

akun atau keterangan, referensi, debit, dan kredit. Semua transaksi secara utuh

dicatat pada satu tempat. Jurnal dikelompokkan kedalam dua jenis, yaitu jurnal

khusus dan jurnal umum.

1. Jurnal Umum

Menurut Bahri Dkk (2020:66) pencatatan transaksi harian dilakukan

melalui jurnal umum Yang selanjutnya disebut sebagai jurnal. Secara

kronologis berdasarkan tanggal kolom referensi diisi dengan nomor akan

seperti yang tertera pada bagan akun ( Chart Of Account) entitas, biasanya

akan terkait sudah dipindahkan ke dalam buku besar.
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2. Jurnal Khusus

Jurnal khusus adalah jurnal yang telah dikelompokkan berdasarkan

bentuk transaksi atau pada sebuah usaha yang transaksinya banyak dan

terus berulang. Jurnal khusus inilah akan mengurangi kemungkinan

perubahan dalam catatan akuntansi. Jurnal khusus dibagi menjadi empat

jenis yaitu:

a. Jurnal penjualan, digunakan untuk mencatat seluruh transaksi

penjualan barang dagang ke pelanggan secara kredit dan.

b. Jurnal khusus penerimaan kas, digunakan untuk melakukan

pencatatan penerimaan kas dari berbagai sumber penerimaan kas

dalam perusahaan

c. Jurnal pembelian, digunakan untuk mencatat transaksi pembelian

barang dagang dari supplier secara kredit.

d. Jurnal pengeluaran kas, digunakan untuk mencatat aktivitas

pengeluaran kas dari berbagai sumber pengeluaran kas dalam

perusahaan.

2.2.3 Posting

Posting adalah tahap kedua dalam proses akuntansi yaitu

memindahkan data pembukuan dari jurnal, ke masing-masing akun buku

besar dan untuk akun tertentu yang perlu dirinci, juga dilakukan posting ke

akun tambahan dalam buku tambahan yang bersangkutan. Misalnya

pioutang usaha dirinci dalam Buku Piutang Usaha yang merupakan

kumpulan akun tambahan masing-masing debitur (Hans Kartikahadi 2019)



17

Langkah-langkah melakukan posting adalah sebagai berikut :

a. Mengidentifikasi nama akun yang terkait dan memindahkan jumlah pada

kolom debit/kredit ke kolom debit/kredit pada akun di buku besar.

b. Menuliskan kode nomor akun pada kolom referensi di jurnal dan halaman

jurnal pada kolom referensi akun di buku besar.

c. Setelah proses pemindahanbukuan selesai, saldo akhir masing – masing

akun dalam buku besar ditentukan dan nantinya dipindahkan ke buku

besar.

2.2.4 Buku Besar

Menurut Bahri,Dkk (2020:85) Pemindahbukuan (Posting) merupakan

langkah untuk melakukan klasifikasi akun-akun yang sesuai dalam buku besar

(Ledger). Langkah-langkah melakukan posting adalah sebagai berikut :

a) Mengidentifikasi nama akun yang terkait dan memindahkan jumlah

pada kolom debit/kredit pada akun buku besar.

b) Menuliskan kode nomor pada akun pada kolom referensi di jurnal

dan halaman jumlah pada kolom referensi akun dibuku besar.

c) Setelah proses pemindahan bukuan selesai, saldo akhir dipindahkan

ke buku besar.

2.2.5 Neraca Saldo

Menurut Bahri,Dkk (2020) Neraca saldo berisikan saldo akhir

kumpulan akun pada akhir periode. Penyusunan neraca saldo disusun

berdasarkan saldo normal akun debit dan kredit. Dimulai dari akun aset,



18

liabilitas, ekuitas, pendapatan, dan beban. Neraca saldo tidak dimaksudkan

untuk memastikan bahwa seluruh transaksi dan posting ke buku besar

telah dilakukan dengan benar. Sebaiknya saldo debit dan kredit neraca

saldo harus seimbang.

2.2.6 Jurnal Penyesuaian

Laporan keuangan yang disusun berdasarkan Standar Akuntansi

Keuangan berlandaskan asumsi dasar kelangsungan usaha dan dasar akrual.

Kelangsungan usaha berarti perusahaan akan terus berusaha tanpa batas

waktu. Tapi tentunya tidak berarti laporan keuangan barulah disusun

menunggu pada saat suatu Perusahaan tidak beroperasi lagi atau ketika

dilikuidasi. Secara periodik perlu disusun laporan keuangan interim

bulanan, kuartalan, maupun laporan semesteran.

Ketika penutupan buku dan laporan keuangan akan disusun, lazimnya

data pembukuan masih belum lengkap mencerminkan transaksi dan

kejadian untuk periode akuntansi yang bersangkutan. Asumsi dasar akrual

menuntut adanya penyesuaian atas catatan akuntansi yang ada, agar

pendapatan dan beban dapat dibukukan, diperhitungkan, dan dilaporkan

secara andal dan sesuai prinsip dasar “memperhitungkan beban sepadan

dengan pendapatan” (matching cost against revenue). Oleh karena itu,

pada saat penyesunan laporan keuangan perlu dilakukan penyesuaian

(adjustment) agar data akuntansi dapat dimutakhirkan (update).

Penyesuaian data tersebut dalam proses akuntansi dikenal sebagai
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melakukan ayat jurnal penyesuaian (adjusting entries) (Hans Kartikahadi

2019).

Ada empat akun yang memerlukan penyesuaian yaitu :

a. Beban yang masih harus dibayar

b. Pendapatan yang masih harus diterima

c. Beban yang ditangguhkan atau dibiaya dibayar dimuka

d. Pendapatan yang ditangguhkan atau pendapatan diterima dimuka

2.2.7 Neraca Saldo Disesuaikan

Menurut Bahri,Dkk (2016:86) setelah neraca saldo disesuaikan maka

akan dipilih kembali agar dapat disusun menjadi laporan laba rugi

komprehensif, laporan perubahan saldo laba, laporan posisi keuangan,

laporan perubahan arus kas dan catatan atas laporan keuangan.

2.2.8 Lembar Kerja

Menurut Bahri,Dkk ( 2020) adalah suatu lembar dokumen dimana

berisi neraca saldo, jurnal penyesuaian, neraca saldo setelah penyesuaian,

laporan laba rugi komprehensif, laporan posisi keuangan, dan laporan

perubahan saldo laba.

2.2.9 Laporan Keuangan

Neraca saldo disesuaikan telah disusun, lalau dipilah agar dapat

disusun menjadi lapoaran keuangan. Yaitu laporan laba rugi, laporan
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perubahan saldo laba, dan laporan posisi keuangan. Laporan keuangan

merupakan hasil terpenting dari siklus akuntansi.

2.2.10 Jurnal Penutup

Tahap akhir dalam proses akuntansi adalah menutup seluruh akun laba

rugi atau akun nominal ke dalam akun Ikhtisar Laba Rugi. Dengan

dilakukannya proses penutupan ini, seluruh akun laba rugi dibersihkan

dari pembukuan, sehingga seluruh transaksi dan kejadian yang terjadi

selama periode akuntansi yang telah berakhir tidak lagi tercantum dalam

pembukuan aktif. Hal ini memungkinkan perusahaan untuk memulai

periode akuntansi yang baru dengan membuka lembaran pembukuan baru

yang memiliki saldo awal nol pada akun-akun nominal. (Hans Kartikahadi,

2019)

2.2.11 Ayat Jurnal Balik

Menurut Bahri,Dkk (2020) beberapa transaksi yang dibayarkandi

perode berikutnya seringkali terkait dengan transaksi yang diakui pada

periode sebelumnya. Untuk mengurangi resiko seperti ini maka

ditawarkan solusi yang berifat opsional yaitu membuat jurnal pembalik.

Jurnal pembalik ini dibuat pada awal periode selanjutnya dan secara

khusus ditetapkan untuk dua jenis ayat jurnal penyesuaian, yaitu beban

yang harus dibayar dan pendapatan yang masih diterima.
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2.3 Laporan Keuangan

2.3.1 Pengertian Laporan Keuangan

Menurut PSAK No. 1 tahun 2022, Laporan Keuangan adalah penyajian

terstruktur dari posisi keuangan dan kinerja keuangan suatu entitas. Laporan

keuangan ini berfungsi sebagai alat komunikasi bagi pihak-pihak yang

berkepentingan dengan data keuangan atau aktivitas perusahaan.

2.3.2 Penyajian Laporan Keuangan

Menurut Ikatan Akuntan Indonesia (IAI, 2018:08), laporan keuangan

bertujuan untuk menyediakan informasi mengenai posisi keuangan, kinerja, serta

perubahan posisi keuangan suatu entitas yang berguna bagi para pemakai dalam

proses pengambilan keputusan ekonomi.Laporan keuangan yang disusun untuk

kepentingan pihak eksternal, seperti investor dan kreditor, dikenal sebagai laporan

keuangan umum (general purpose financial statements). Laporan ini bersifat resmi

dan penyusunannya harus mematuhi ketentuan-ketentuan yang tercantum dalam

Prinsip Akuntansi Berterima Umum (PABU) atau Generally Accepted

Accounting Principles (GAAP). Sementara itu, untuk kepentingan internal dan

operasional, manajemen memerlukan laporan yang digunakan dalam pelaksanaan

kegiatan operasional, pengendalian, koordinasi, evaluasi, serta perencanaan

perusahaan. Laporan semacam ini biasa disebut sebagai laporan

manajerial (managerial reports), yang disusun dengan menyesuaikan kebutuhan

informasi internal dan tidak wajib mengikuti PABU. format dan isi laporan

manejerial tidak harus mengikuti PABU karena sifatnya yang individual sesuai

dengan kebutuhan manajemen. Laporan Keuangan terdiri atas :
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1) Laporan Posisi keuangan

2) Laporan Laba Rugi

3) Laporan Perubahan Ekuitas

4) Laporan Arus Kas

5) Catatan Atas Laporan Keuangan

2.3.3 Tujuan Laporan Keuangan

Menurut Martani dkk, (2016:09) Secara umum tujuan lpaoran keuangan

adalah sebagai berikut:

a) Memberikan Informasi yang menyangkut posisi keuangan, kinerja

serta perubahan posisi keuangan suatu entitas yang bermanfaat bagi

sejumlah besar pemakai dalam pengambilan keputusan ekonomi.

b) Menunjukan apa yang telah dilakukan manajemen (Stewardship) dan

pertanggungjawaban sumber daya yang dipercayakan kepadanya.

c) Memenuhi kebutuhan bersama sebagian besar pemakai.

d) Menyediakan pengaruh keuangan dari kejadian masa lalu.

2.4 Akuntansi Perusahaan Dagang

Akuntansi perusahaan dagang menurut ( Warren et al, 2017 ) merupakan

kegiatan operasional perusahaan dengan meliputi pembelian barang untuk dijual

( aktivitas pembelian), Penjualan dam distribusi barang ( aktivitas penjualan).

serta penerimaan kas dari pelanggan ( aktivitas penagihan). keseluruhan proses
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mengacu pada siklus operasi. operasi berawal dari mengeluarkan uang dan

berakhir dengan menerima uang dari pelanggan. Siklus operasi untuk perusahaan

dagang ditunjukkan seperti berikut ini :

Sumber: Pengantar Akuntansi 1 ( Warren et,al 2017)

2.4.1 Akun-Akun Perusahaan Dagang

Perusahaan Dagang memiliki akun-akun yang tidak di jumpai pada

jenis perusahaan lain, antara lain :

1. Akun persediaan barang dagang

2. Akun harga pokok penjualan

3. Akun retur pembelian/ penjualan

4. Akun potongan pembelian/ penjualan

5. Akun biaya atas pengiriman

6. Akun penjualan

KAS

Aktifitas
Penagihan

Piutang
Usaha

Aktifitas
Penjualan

Aktifitas
Pembelian

Produk

Siklus
Operasi
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2.4.2 Karakteristik Perusahaan Dagang

Karakteristik Khusus yang dimiliki oleh perusahaan dagang adalah

sebagai berikut :

1. Perusahaan dagang menawarkan produk yang jelas wujudnya

2. Dalam perusahaan dagang, laba diperoleh dari selisih harga jual

dengan harga pokok penjualan

3. Kegiatan usahanya adalah membeli barang dagangan dan

menjualnya tanpa merubah bentuk barang tersebut.

4. Menggunakan akun persediaan barang yang terdiri atas persediaan

awal dan persediaan akhir.

5. Memiliki perhitungan harga pokok penjualan.

2.4.3 Transaksi Perusahaan Dagang

Menurut Warren dkk, (2017:284) terdapat dua system untuk akuntansi

transaksi perusahaan dagang yaitu metode perpetual dan metode periodik. dalam

System persediaan perpetual setiap pembelian dan penjualan barang dicatat dalam

akun persediaan dan buku besar yang berkaitan. jadi, jumlah barang yang tersedia

untuk dijual dan jumlah yang terjual dilaporkan dalam catatan persediaan secara

terus menerus. Dalam system persediaan periodik catatan persediaan tidak

menunjukkan jumlah yang tersedia untuk dijual atau jumlah yang terjual selama

periode tertentu. Sebagai gantinya, sebuah daftar yang tersedia yang disebut

persediaan fisik, disiapkan pada akhir periode akuntansi. Persediaan fisik

digunakan untuk untuk menentukan nilai persediaan yang tersedia pada akhir

periode dan nilai persediaan yang terjual selama periode tertentu.
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2.4.4 Laporan Keuangan Untuk Prusahaan Dagang

Menurut Warren,dkk (2017 :299) :

a. Laporan Laba Rugi Bentuk Tidak Langsung

Berisi beberapa bagian, subbagian, dan subjumlah. Diantaranya

penjualan, beban pokok penjualan, laba bruto, laba dari kegiatan

operasi, pendapatan dan beban lainnya dan pendapatan lainnya.

b. Laporan Laba Rugi Bentuk Langsung

Mengurangkan secara langsung jumlah seluruh beban dari jumlah

pendapatan . Bentuk langsung menekankan jumlah pendapatan dan

jumlah beban sebagai faktor yang menentukan laba neto. kritik

terhadap bentuk langsung adalah beberapa angka seperti laba bruto

dan laba operasi yang tidak tersedia.

c. Laporan Ekuitas Pemilik

Menyajikan perubahan dalam ekuitas pemilik suatu waktu tertentu.

Laporan ini dibuat setelah laporan laba rugi karena laba neto atau

rugi neto periode harus dilaporkan di periode ini. Laporan ini

disiapkan sebelum laporan posisi keuangan, karena jumlah ekuitas

pemilik pada periode harus dilaporkan dilaporan posisi keuangan.

Oleh karena itu laporan ekuitas pemilik sering dilihat sebagai

penghubung antara laporan laba rugi dan laporan posisi keuangan.

d. Laporan Posisi Keuangan

Laporan posisi keuangan terdapat aset yang berada di sisi kiri dan

liabilitas dan ekuitas pemilik berada di sisi kanan.
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e. Proses Penyusunan dan Penutupan

Analisis dan pemuktahiran akun-akun pada akhir periode sebelum

laporan keuangan disiapkan disebit proses penyesuaian. Dan proses

pemindahan disebut proses penutupan atau kadang disebut sebagai

tutup buku.

f. Ayat Jurnal Penyesuaian Untuk Kehidupan Persediaan

Perusahaan dagang mungkin mengalami kehilangan persediaan

karena pencurian di toko, pencurian oleh karyawan, atau kesalahan

dalam pencatatan atau perhitungan persediaan. Akibatnya,

perhitungan persediaan secara fisik yang dilakukan pada akhir

periode akutansi lebih kecil dari pada jumlah persediaan yang

ditunjukkan dalam pencatatan persediaa.karena alasan ini, selisih

tersebut sering dinamakan penyusutan persediaan atau kehilangan

persediaan .

g. Ayat Jurnal Penutup

Ayat jurnal penutup untuk perusahaan dagang sama dengan ayat

jurnal perusahaan jasa. Empat ayat jurnal penutup untuk perusahaan

dagang adalah sebagai berikut :

 Mendebit akun-akun sementara dengan saldo kredit seperti

penjualan, dan mengkreditan akun ikhtisar laba rugi.

 Mengkreditkan akun-akun sementara dengan saldo debit

seperti berbagai beban dan mendebit akun ikhtisar laba rugi.

Oleh karena beban pokok penjualan adalah akun sementara
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dengan saldo debit, maka akun-akun tersebut dikreditkan

sebesar-sebesarnya saldonya.

 Mendebit akun ikhtisar laba rugi sebesar saldonya (laba neto)

dan mengkredit akun modal pemilik. Jika perusahaan

mengalami rugi neto, maka yang di kredit adalah akun

ikhtosar laba rugi sebesar saldonya dan yang di debitkan

modal pemilik.

 Mendebit akun modal pemilik sebesar saldo akun prive, dan

mengkreditkan prive.

2.4.5 Sistem Pencatatan Persediaan

1. Sistem Periodik

Menurut Martani,dkk ( 2016: 250) Sistem periodik merupakan system

pencatatan persediaan dimana kuantitas persediaan dimana kuantitas secara

periodik yaitu hanya pada saat perhitungan fisik yang biasanya dilakukan

secara Stock Opname.

2. Sistem Perpetual

Menurut Martani,dkk ( 2016:250) Sistem Perpetual merupakan system

pencatatan persediaan dimana pencatatan yang up-to-date terhadap barang

perediaan selalu dilakukan setiap terjadi perubahan nilai persediaan.
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2.4.6 Metode Biaya Persediaan

1. Metode Masuk-Pertama, Keluar- Pertama (FIFO)

Menurut Warren dkk, (2017:346) berdasarkan metode masuk-

pertama, keluar pertama ( first-in, first-out fifo) , unit pertama yang dibeli

di asumsikan telah dijual dan persediaan akhir berasal dari pembelian

terakhir.

2. Metode Biaya Rata-Rata Tertimbang

Menurut Warren, (2017:347) metode biaya rata-rata tertimbang

( waight average inventory cost flaw method) atau seiring disebut metode

biaya rata-rata ( Average cost flow method) digunakan, biaya unit terjual

dan persediaan akhir merupakan rata-rata tertimbang biaya pembelian .

Biaya pembelian diperoleh dari jumlah rata-rata barang yang dibeli dikali

dengan masing-masing harganya.sehingga disebut dengan rata-rata

tertimbang.

2.4.7 Nomor Akun (Chart Of Account) dan Nama Akun

Daftar akun disusun berdasarkan subklasifikasi dan pengelompokan

sesuai dengan format penyajian dalam laporan keuangan. Akun-akun

perusahaan umumnya diklasifikasikan ke dalam dua kelompok utama,

yaitu kelompok akun neraca dan kelompok akun laporan laba rugi.

Selanjutnya, akun-akun tersebut disubklasifikasikan menjadi beberapa

kategori seperti aset lancar, aset tetap, kewajiban lancar, kewajiban

jangka panjang, dan ekuitas (modal).
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Kelompok akun neraca dikenal sebagai akun riil (real accounts),

sedangkan kelompok akun yang mencerminkan perubahan dalam modal,

seperti pendapatan, beban, setoran, dan pengambilan, disebut akun

nominal atau akun sementara. Contoh penomoran dan nama akun dapat

dilihat pada gambar.

Tabel 2.1 Nomor Akun

Contoh dan Nomor Akun Neraca

Kode Kategor i Kode Kategor i

100 Aset 200 Kewajiban lancar

110 Aset Lancar 210 Utang Usaha

Kode Kategor i Kode Kategor i

111 Kas Bank A 300 Ekuitas

112 Kas Bank B 310 Modal A

Kode Kategor i Kode Kategor i

115 Persediaan Barang

Dagang

- Modal B

117 Asset tetap - Laba di tahan

119 Peralatan Toko

120 Akm Peny

Peralatan toko

Contoh dan Nomor Akun Laba Rugi

Kode Kategori Kode Kategori

410 Penjualan Barang

dagang

610 Beban

Operasional

510 Harga Pokok

Penjualan

615 Beban Gaji

510 Harga Pokok Barang 619 Beban Sewa

- Beban Angkut 623 Beban lain-lain
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Kode Kategori Kode Kategori

- Potongan pembelian - Pendapatan Bunga

Bank

- Retur Penjualan - Biaya Bunga

Bank

2.5 Standar Akuntansi Keuangan Entitas Mikro Kecil dan Menengah (SAK

EMKM)

Menurut Ikatan Akuntan Indonesia (IAI, 2018:01), Entitas Mikro, Kecil,

dan Menengah (EMKM) adalah entitas yang tidak memiliki akuntabilitas publik

yang signifikan sebagaimana didefinisikan dalam Standar Akuntansi Keuangan

Entitas Tanpa Akuntabilitas Publik (SAK-ETAP), serta memenuhi definisi dan

kriteria usaha mikro, kecil, dan menengah sebagaimana diatur dalam peraturan

perundang-undangan yang berlaku di Indonesia, sekurang-kurangnya selama dua

tahun berturut-turut.

Penerbitan SAK-EMKM diharapkan dapat menjadi salah satu upaya peningkatan

literasi keuangan bagi pelaku UMKM di Indonesia. Dengan demikian, pelaku

usaha di sektor ini memperoleh akses yang lebih luas terhadap pembiayaan dari

sektor perbankan, yang selama ini merupakan tantangan klasik dalam

pengembangan UMKM di Indonesia. Selain itu, SAK-EMKM juga diharapkan

dapat menjadi landasan dalam penyusunan serta pengembangan pedoman atau

panduan akuntansi bagi UMKM yang bergerak di berbagai sektor usaha.

2.6 Pelaporan Keuangan Berdasarkan SAK EMKM

Menurut Ikatan Akuntansi Indoensia (IAI), (2018:08) Laporan

Keuangan terdiri dari :
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1. Laporan Laba Rugi Selama Periode

2. Laporan Posisi Keuangan pada akhir periode

3. Catatan Atas Laporan Keuangan yang berisi tambahan dari rincian pos-

pos tertentu yang relevan.

2.6.1 Laporan Laba Rugi

Laporan Laba Rugi entitas dapat mencakup pos-pos sebagai berikut:

1. Pendapatan

2. Beban Keuangan

3. Beban Pajak

Gambar 2.2 Laporan Laba Rugi EMKM

Sumber : (SAKEMKM) Efektif Per 1 Januari 2019

2.6.2 Laporan Posisi Keuangan

Laporan Posisi Keuangan entitas dapat mencakup pos-pos berikut:

1. Kas dan Setara kas

2. Piutang
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3. Persediaan

4. Aset tetap

5. Utang usaha

6. Utang bank

7. Ekuitas

Gambar 2.3 Laporan Posisi Keuangan EMKM

Sumber : (SAK EMKM) Efektif Per 1 Januari 2019

Untuk menyajikan pos dan bagian dan pos dalam laporan laba rugi jika

penyajian tersebut relavan untuk memahami kinerja keuangan entitas. Laporan

laba rugi memasukan semua penghasilan dan beban yang diakui dalam suatu
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periode kecuali SAK EMKM mensyaratkan lain. SAK EMKM mengatur

perlakuan atas dampak koreksi atau kesalahan dan perubahan kebijakanakuntansi

yang disajikan sebagai penyesuaian retrospektif terhadap periode terjadinya

perubahan.

2.6.3 Catatan Atas Laporan Keuangan

Catatan Atas Laporan Keuangan (CALK) menurut (IAI,2022) berisi

tentang :

a) Sebuah Pernyataan bahwa laporan keuangan telah disusun sesuai

dengan ED SAK-EMKM

b) Ikhtisar kebijakan akuntansi

c) Dan informasi tambahan dan rincian akun tertentu yang menjelaskan

transaksi yang penting dan material sehingga bermanfaat bagi

pengguna untuk memahami laporan keuangan.

Jenis Informasi tambahan dan rincian yang disajikan bergantung pada

jenis kegiatan usaha yang dilakukan oleh entitas. Catatan Atas Laporan Keuangan

disajikan secara sistematis sepanjang hal tersebut praktis. Setiap pos dalam

laporan keuangan merujuk-silang ke informasi terkait dalam catatan atas laporan

keuangan.

2.7 Aplikasi Microsoft Excel

2.7.1 Pengertian Aplikasi Microsoft Excel

Microsoft Excel adalah sebuah program yang merupakan bagian dari paket

Microsoft Office. Menurut Pratiwi (2021), Excel adalah aplikasi lembar kerja



34

elektronik (Spreedsheet) yang canggih dan mudah digunakan untuk menghitung,

memproyeksikan, menganalisis, dan mempresentasikan data dalam bentuk

diagram, grafik, serta berbagai tabel. Microsoft Excel adalah aplikasi lembar kerja

elektronik yang canggih dan user-friendly. Dikembangkan dan didistribusikan

oleh Microsoft Coorporation, ˆPerusahaan perangkat lunak terkemuka di dunia

yang menyediakan solusi untuk sistem operasi Microsoft Wimdows dan Mac OS.

Rohmah & Hastuti (2022).

Excel merupakan sebuah program yang cukup familiar bagi semua kalangan.

setiap orang pernah menggunakan computer dan setidaknya mengerti dengan

Excel karena Excel merupakan program standar yang selalu di instalisasikan ke

dalam komputer. Sebelum mengelola data menjadi laporan, kita akan membuat

lembar kerja hingga lembar kerja tersebut menjadi sebuag aplikasi. Setelah

menjadi aplikasi, maka Excel akan langsung dapat mengolah data menjadi laporan

keuangan dengan hanya memasukan sedikit data secara manual.

Dengan demikian, Excel bukan hanya alat untuk mengelola angka, tetapi

juga merupakan alat yang sangat efektif untuk analisis data mendalam dan

visualisai informasi. Aplikasi ini dapat digunakan oleh individu, bisnis dan

organisasi untuk berbagai keperluan dan perencanaan keuangan sehingga analisis

bisnis yang kompleks. Excel telah menjadi salah satu aplikasi yang penting dan

populer di dunia profesional dan akademis karena fleksibelitasnya dalam

mengolah dan menyajikan informasi secara efesien.
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2.7.2 Prosedur Pengoperasian Microsoft Excel

2.7.2.1 Menggerakkan Petunjuk Sel (Cell Pointer)

Cell Pointer berfungsi untuk petunjuk sel aktif. yang dimaksud dengan sel

aktif ialah sel yang akan dilakukan suatu operasi tertentu. Untuk menggerakan

pointer dengan Mouse dapat dilakukan dengan meng-klik sel yang diinginkan.

untuk sel yang tidak kelihatan kita dapat menggunakan Scroll Bar untuk

menggeser layar hingga sel yang dicari kelihatan lalu klik sel tersebut. Untuk

Kondisi tertentu lebih baik menggunakan keyboard. Berikut adalah daftar tombol

(Shortcut) yang digunakan menggerakan pointer dengan keyboard.

Gambar : 2.4 Petunjuk Sel (Cell Pointer)

Tombol Fungsi
Tanda Panah Pindah satu sel ke kiri, atas, kanan,bawah
Tab Pindah Satu Sel ke kanan
Enter Pindah Satu Sel ke bawah
Shift+Tab Pindah satu sel ke kiri
Shift+ Enter Pindah Satu sel ke atas
Home Pindah ke kolom A pada baris yang sedang di

pilih
Ctrl + Home Pindah ke sel A1 pada lembar kerja yang aktif
Ctrl+ End Pindah ke posisi sel terakhir yang sedang

digunakan
PgUp Pindah satu layar ke atas
PgDn Pindah satu layar ke bawah
Alt+ PgUP Pindah Satu layar ke kiri
Alt+PgDn Pindah satu layar ke kanan
Ctrl+PgUp Pindah dari satu tab lembar kerja ke tab lembar

berikutnya
Ctrl+ PgDn Pindah dari suatu tab lembar kerja ke tab

lembar sebelumnya

2.7.2.2 Penggunaan Rumus

Rumus merupakan bagian terpenting dalam program Microsoft Excel,

karena setiap table dan dokumen yang kita kerjakan selalu berhubungan dengan

rumus dan fungsi. Operator matematika yang sering digunakan setiap dalam

rumus adalah :



36

Table 2.2 Operator Matematika

Lambang Fungsi

+ Penjumlahan

- Pengurangan

* Perkalian

/ Pembagian

^ Perpangkatan

% Presentase

Rumus Excel adalah persamaan atau instruksi yang digunakan untuk

melakukan perhitungan atau operasi pada data di lembar kerja. Rumus ini

dimulai dengan tanda sama dengan (=) dan dapat berisi fungsi, referensi sel,

operator , dan konstanta.

Fungsi Rumus Excel adalah perintah bawaan yang telah disediakan Excel

untuk melakukan perhitungan atau tindakan tertentu, seperti menjumlahkan

( SUM), menghitung rata-rata ( AVERAGE), atau melakukan logika (IF).

Referensi Sel Excel adalah cara untuk mengacu pada nilai yang ada di sel

lain dalam rumus. Misalnya “A1” mengacu pada sel A1, dan “A1:A5” mengacu

pada rentang sel A1 hingga A5.

Operator Excel adalah simbol yang menunjukkan jenis operasi yang akan

dilakukan pada nilai, seperti “+” untuk penjumlahan, “-” untuk Pengurangan, “*”

untuk Perkalian, “/” untuk pembagian.

Konstanta Excel adalah nilai yang dimasukkan secara langsung ke dalam

rumus, seperti angka atau teks. Misalnya “10” adalah konstanta.
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2.7.3 Fungsi yang digunakan dalam Excel For Accounting

2.7.3.1 Fungsi Sum

Penjumlahan Data dengan SUM merupakan perhitungan yang sangat

sederhana dan mudah dilakukan. SUM dapat digunakan untuk menjumlahkan

nilai-nilai yang terdapat pada beberapa sel dalam suatu range tertentu. Rumus

Fungsi SUM sebagai berikut :

=SUM ( range)

Range adalah kumpulan sel yang berdekatan yang dipilih untuk

melakukan operasi seperti memasukan data, menerapkan format atau

menggunakan rumus.

2.7.3.2 Fungsi IF

Fungsi IF digunakan untuk membuat pernyataan logis dalam Spreadsheet,

yang menghasilkan nilai berbeda tergantung pada apakah kondisi tertentu

terpebuhi atau tidak. Jika kondisi yang di uji benar (TRUE), maka fungsi akan

mengembalikan nilai yang dutentukan, dan jika kondisi salah (FALSE), maka

akan mengembalikan nilai yang berbeda. Bentuk penulisan fungsi IF sebagai

berikut:

 Uji_logika (Logical_test) adalah bagian dari rumus yang di evaluasi

sebagai BENAR atau SALAH. Contohnya : A1>10 ( Apakah nilai sel A1

lebih dari 10), B2=C2 ( Apakah nilai sel B2 sama dengan sel C2), atau

D3<>0 ( apakah nilai di sel D3 tidak sama dengan 0).
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 Nilai_jika_benar ( Value_if_true) adalah nilai atau rumus yang akan

dikembalikan jika Uji_logika bernilai BENAR. Contohnya : “LULUS”,

10 atau rumus lain yang valid atau nilai jawaban (pertama) akan

diberikan jika syarat dipenuhi.

 Nilai_jika_salah ( Value_if_false) adalah nilai atau rumus yang akan

dikembalikan jika Uji_logika_bernilai SALAH. Contohnya”gagal”,0 atau

rumus lain yang valid.

2.7.3.3 Fungsi Sumif

Fungsi Sumif di Microsoft Excel digunakan untuk menjumlahkan nilai-

nilai dalam suatu rentang yang memenuhi kriteria tertentu. Ini memungkinkan

untuk melakukan penjumlahan dengan kondisi, bukan hanya menjumlahkan

semua nilai dalam rentang.

Fungsi Sumif mengambil tiga argumen :

 Range : Rentang sel yang akan di evaluasi berdasarkan kriteria.

Contohnya : Range : Kolom A ( Sel yang berisi nama produk)

 Criteria : Kriteria yang menentukan sel mana yang akan ditambahkan.

Kriteria bisa berupa angka, ekspresi, referensi sel, teks atau fungsi.

Contohnya : “A” (Nama Produk yang ingin dijumlahkan)

 Sum_range (Opsional): Rentang sel yang sebenarnya akan dijumlahkan.

Jika argumen ini dihilangkan. Excel akan menjumlahkan sel yang ada

dalam range.

Contohnya : Sum_range : Kolom B (Sel yang berisi jumlah penjualan)

=SUMIF ( range:criteria:sum_range)
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Rumusnya akan menjadi : = SUMIF (A1:A10, “A”, B1:B10).

2.7.3.4 Fungsi COUNTIF

Fungsi COUNTIF adalah fungsi statistik yang digunakan untuk menghitung

jumlah sel dalam suatu rentang yang memenuhi kriteria tertentu. kriteria ini bisa

berupa angka, teks atau operator perbandingan.

Cara kerja fungsi COUNTIF sebagai berikut :

 Rentang : digunakan untuk menentukan rentang sel yang akan diperiksa.

 Kriteria : digunakan untuk menentukan kondisi atau kriteria yang akan

dicari dalam rentang tersebut. Kriteria bisa berupa nilai, teks, atau

operator perbandingan seperti >5, <10, =”Jakarta”.

 Hasil : Fungsi COUNTIF akan menghitung jumlah sel dalam rentang

yang memenuhi kriteria yang ditentukan.

=COUNTIF(range, criteria)

-range : rentang sel yang akan di periksa

-criteria : kriteria yang akan dicari

2.7.3.5 Fungsi VLOOKUP

Fungsi VLOOKUP adalah fungsi yang digunakan untuk membaca table data

secara vertical sesuai dengan kriteria kolom paling awal dalam suatu range tabel

data. Bentuk penulisan fungsi VLOOKUP sebagai berikut :

=VLOOKUP(lookup_Value;table_array;colom_index_num;range_lookup)

 Lookup : Nilai yang dijadikan kriteria untuk membaca tabel data
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 Table-array : range tabel memuat data-data yang akan di baca dan lookup

value terdapat dalam range tabel tersebut pada urutan kolom pertama.

 colomn : nomor urut kolom yang memuat data yang akan dibaca dan dihitung

dari urutan kolom paling awal data tabel (table_array).

2.7.3.6 Rumus Fungsi IF dan OR

Rumus fungsi IF dam OR digunakan dalam Excel untuk melakukan

pengujian kondisi logika. IF digunakan untuk mengembalikan nilai tertentu jika

kondisi terpenuhi. sedangkan OR digunakan untuk mengevaluasi beberapa

kondisi dan mengembalikan TRUE jika salah satu atau lebih terpenuhi.

: =IF(OR(log_test_1;log_test_2;log_test_n);value_if_true;value_if_false)

 Uji_logika (Logical_test) adalah bagian dari rumus yang di evaluasi

sebagai BENAR atau SALAH. Contohnya : A1>8 ( Apakah nilai sel A1

lebih dari 8), D2=E2 ( Apakah nilai sel D2 sama dengan sel E2), atau

F3<>0 ( apakah nilai di sel F3 tidak sama dengan 0).

 Nilai_jika_benar ( Value_if_true) adalah nilai atau rumus yang akan

dikembalikan jika Uji_logika bernilai BENAR. Contohnya : “LULUS”, 5

atau rumus lain yang valid atau nilai jawaban (pertama) akan diberikan

jika syarat dipenuhi.

 Nilai_jika_salah ( Value_if_false) adalah nilai atau rumus yang akan

dikembalikan jika Uji_logika_bernilai SALAH. Contohnya”gagal”,0 atau

rumus lain yang valid.
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2.7.3.7 Rumus Fungsi IF dan AND

Dalam memberikan isyarat, fungsi IF dapat menggunakan fungsi logika

AND. Fungsi AND digunakan untuk menentukan jawaban berdasarkan semua

syarat. Jika salah satu atau semua syarat ada, maka jawaban terpebuhi. Penulisan

fungsi IF dan AND sebagai berikut:

=IF(AND(log_test_1;log_test_2;log_test_n);value_if_true;value_if_false)

 Uji_logika (Logical_test) adalah bagian dari rumus yang di evaluasi

sebagai BENAR atau SALAH. Contohnya : A1>23 ( Apakah nilai sel A1

lebih dari 8), D1=E1 ( Apakah nilai sel D1 sama dengan sel E1), atau

H3<>0 ( apakah nilai di sel H3 tidak sama dengan 0).

 Nilai_jika_benar ( Value_if_true) adalah nilai atau rumus yang akan

dikembalikan jika Uji_logika bernilai BENAR. Contohnya : “LULUS”, 7

atau rumus lain yang valid atau nilai jawaban (pertama) akan diberikan

jika syarat dipenuhi.

 Nilai_jika_salah ( Value_if_false) adalah nilai atau rumus yang akan

dikembalikan jika Uji_logika_bernilai SALAH. Contohnya”gagal”,0 atau

rumus lain yang valid.

2.7.4 Menu-menu yang digunakan dalam Excel For Accounting

2.7.4.1 Menu Edit > Copy dan Menu edit > Paste

Menu “Copy” dan “ Paste” pada menu “edit” berfungsi untuk menyalin

dan menempelkan konten ( teks, gambar, dll) di berbagai aplikasi. Menu “Copy”

(Ctrl+C atau Command + C pada Mac) menyalin konten terpilih ke clipboard,
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sementara menu “Paste” ( Ctrl+V atau Command V pada Mac) menempelkan

konten dari clipboard ke lokasi yang di inginkan.

2.7.4.2 Menu Format> Sheet> Rename

Menu ini digunakan untuk mengganti nama sheet. Klik menu Format >

Sheet > Rename, maka posisi kursor akan berpindah pada edit nama sheet, atau

dengan meng-klik dua kali pada sheet, kita dapat mengganti nama sheet sesuai

dengan nama-nama padaWorksheet yang kita buat.

2.7.4.3 Menu Format > Sheet> Difine

Menu ini digunakan untuk memberi nama pada sel range. Untuk memberi

nama pada range tertentu sudah berisi data, pilih menu Insert > Name > Difime

kemudian letakan kursor pada letak dialog Refer to, kemudian pindahkan dan

letakkan kursor pada sel range data yang akan di blok dan blok range yang akan

diberi nama sehingga kotak dialog akan terisi sel atau range yang sudah di blok.

Untuk memberi nama range, letakkan kursor pada dialog Name in Worksheet dan

ketik “Data”, kemudian klik “Add” untuk menambahkan range tersebut ke dalam

daftar nama range . klik “OK”

2.7.4.4 Menu Data > Filter > Auto Filter

Menu ini digunakan untuk membuat filter ( penyaring ) data pada suatu

tabel.
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2.8 Excel For Accounting

Sebelum memulai pemrograman aplikasi akuntansi, sangat penting untuk

terlebih dahulu menyusun konsep dasar dari aplikasi tersebut. Hal ini dikarenakan

aplikasi akuntansi umumnya terdiri dari banyak lembar kerja (sheet) yang saling

terintegrasi. Untuk memudahkan navigasi antar lembar kerja, disarankan agar

menu utama disusun terlebih dahulu. Menu ini akan berfungsi sebagai pusat

navigasi yang memuat tautan ke seluruh lembar kerja yang diperlukan. Adapun

lembar kerja yang direncanakan untuk dibuat antara lain adalah sebagai berikut:

1. Sheet 1 Menu (Format Hyperlink) Lembar kerja ini berfungsi sebagai

menu utama yang digunakan untuk navigasi antar sheet dalam aplikasi,

sehingga memudahkan pengguna dalam mengakses setiap bagian yang

dibutuhkan

2. Sheet 2 Akun, Lembar ini menampilkan seluruh daftar akun yang

digunakan dalam proses transaksi dan penjurnalan. Informasi yang

ditampilkan mencakup kode akun, nama akun, posisi saldo (debit/kredit),

serta posisi dalam laporan keuangan.

3. Sheet 3 transaksi, Lembar ini mencatat seluruh transaksi yang dilakukan

oleh perusahaan selama periode akuntansi tertentu, yang menjadi dasar

dalam proses penjurnalan.

4. Sheet 4 – Kode dan Persediaan Lembar ini menyajikan data mengenai

persediaan barang dagang yang dimiliki perusahaan, termasuk kode

barang dan informasi penting lainnya terkait pengelolaan persediaan.
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5. Sheet 5 – Jurnal Umum Lembar ini berisi seluruh pencatatan jurnal dari

transaksi yang terjadi, yang disusun berdasarkan kaidah akuntansi yang

berlaku.

6. Sheet 6 – Buku Besar Lembar ini menyajikan informasi saldo masing-

masing akun yang berasal dari jurnal umum, termasuk juga saldo awal

perusahaan, guna memudahkan proses pemantauan dan analisis akun.

7. Sheet 7 – Neraca Lajur Lembar ini digunakan sebagai alat bantu dalam

proses penyusunan laporan keuangan, dengan menyusun data keuangan

secara sistematis dalam bentuk kolom-kolom.

8. Sheet 8 – Laporan Laba Rugi Lembar ini menyajikan informasi

mengenai laba atau rugi perusahaan dalam suatu periode akuntansi, yang

dihitung dari selisih antara pendapatan dan seluruh biaya operasional.

9. Sheet 9 – Laporan Posisi Keuangan Lembar ini menggambarkan kondisi

keuangan perusahaan secara menyeluruh pada akhir periode akuntansi,

yang mencakup informasi tentang aset, liabilitas, dan ekuitas.

2.8.1 Menu ( Format Hyperlink)

Untuk mempermudah kita dalam menggunakan program yang kita buat ini

maka kita dapat menggunakan fungsi Format Hyperlink dalam membantu kita

untuk membuka antar sheet. Sehingga kita dapat membuat tampilan menu

tersendiri untuk dapat digunakan sebagai tampilan awal program. Langkah-

langkah yang perlu di buat sebagai berikut :

1. Aktifkan sheet berikutnya dan ganti nama sheet “Menu” dengan cara:

 Lakukan Klik kanan pada sheet baru dan pilih menu Rename.
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 Ketiklah “Menu” pada sheet yang akan diganti namanya.

 Kemudian Enter

2. Buatlah format Menu Awal menggunakan Insert > Shapes seperti

ilustrasi berikut ini :

Gambar : tampilan 2.5 Shapes

Sumber : Microsoft Excel

3. Selanjutnya kita dapat memilih tampilan yang kita inginkan seperti

berikut ini :

Gambar 2.6: Tampilan Menu ( Format Hyperlink)

Sumber : Microsoft Excel
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4. Untuk dapat menampilkan menu yang kita buat saja maka kita dapat

menyembunyikan baris atau kolom yang tidak ingin terlihat. Kita dapat

menggunakan fungsi format > Hide/ Unhide > Row/colom. Langkah-

langkah yang harus kita lakukan adalah :

 Klik Sel K1

 Tekan CTRL+SHIFT + Panah kanan sehingga seluruh sel bagian

kanan akan di blok.

 Pilih menu format > Unhide & hide > Rows /colomn seperti ilustrasi

berikut :

Gambar 2.7 : Tampilan Format hide & unhide

Sumber : Microsft Excel

5. Selanjutnya untuk membuat menu Hyperlink ke sheet tertentu maka kita

dapat melakukan proses sebagai berikut :

 Pilih Sheet yang akan di buatkan hyperlinknya. Selanjutnya pilih

menu hyperlink dengan melakukan klik kanan pada mouse.
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 Pilih Hyperlink dan akan muncul kotak dialog.

 karena kita akan membuat hyperlink ke sheet “Akun” dan akhiri

dengan menekan “OK”.

 Selanjutnya kita cukup memilih menu “ Akun” untuk pergi ke sheet

“ Akun”.

 Dan selanjutnya lakukan proses yang sama untuk menu yang lain.

2.8.2 Rancangan Format Akun dan Saldo Awal

Sel selanjtnya yaitu bagaimana cara membuat rancangan akun dan saldo

awal . Buatlah tabel dan format seperti gambar berikut ini :

Gambar 2.8 Sheet Format Akun

1. Pada Sheet kedua buatlah sheet baru lalu ganti dengan “Akun”

2. Setelah membuat format tabel , tekan kode akun, nama akun dan

saldo awal yang di dapat dari perusahaan .
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3. Untuk mengisi kolom pos saldo dari pos laporan dengan cara

menggunakan Drop Down List dengan cara :

a) Letakkan kursor pada 3 sel yang kosong secara vertikal lalu klik

D, K dan tanda (-)

b) Kemudian Blok Range sel pada C7 : C47 pada kolom D/K

c) klik menu data, pilih data Validation.

d) Pilih List kemudian hilangkan centang pada ignore blank

e) Pada Source sorot 3 sel yang berisi nama D, K, dan tanda (-)

f) Kemudian Klik “OK”

g) Lakukan hal yang sama pada kolom pos laporan dan mengganti

nama pada sel D,K, dan tanda (-) menjadi LPK dan L/R.

2.8.3 Rancangan Format Daftar Buku Pembantu

Langkah-langkah :

1. Buatlah lembar kerja kode pembantu pada sheet-2 seperti gambar

berikut :

Gambar 2.9 Format Daftar Buku Pembantu
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2. Ganti nama Sheet-2 menjadi “ Daftar Buku Pembantu”

3. Isikan lembar kerja tersebut dengan daftar buku pembantu dan saldo

awal buku pembantu .

4. Untuk kode, nama dan saldo awal dilakukan dengan cara manual/

diketik.

5. Untuk status dilakukan dengan cara menggunakan data validation

yang berisikan hutang dan piutang.

2.8.4 Rancangan Format Sheet Transaksi

Buatlah tabel dan format seperti gambar dibawah ini :

Gambar 2.10 Sheet Data Transaksi

1. Klik sheet 3 lalu ganti nama sheet menjadi “ transaksi”

2. Pada sel E6 isikan tanggal untuk periode transaksi



50

3. Pada sel F6 isikan data keterangan yang berhubungan dengan transaksi

pada tanggal tersebut.

4. Pada sel G6 isikan harga pokok penjualan sesuai dengan berapa barang

yang terjual agar nantinya perusahaan mengetahui harga pokok penjualan

barang.

5. Pada sel H6 isikan data jumlah penjualan sesuai dengan data keterangan

penjualan.

2.8.5 Rancangan Format Kode dan Persediaan

Buatlah tabel seperti gambar berikut ini :

Gambar 2.10 Kode & Persediaan

1. Klik Sheet ke 4 lalu ganti nama dengan sheet menjadi “Kode dan

Persediaan”

2. Isi kolom dengan kode barang

3. Isi kolom dengan nama barang

4. Isi kolom dengan harga beli barang
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5. Isi kolom dengan harga jual barang

6. Isi kolom dengan stok awal barang

7. Isi kolom masuk isi sel I7 - J7 dengan rumus : = SUMIF

(bantu;kode;”Jurnal Umum’!L:L)

8. Pada kolom stok akhir isi dengan rumus = F7 + G7- H7

9. Pada kolom total saldo awal dengan rumus = D7*F7

10. Pada kolom total saldo akhir dengan rumus = D7*I7

2.8.6 Keterangan Format Sheet Jurnal Umum

Gambar 2.11 Format Jurnal Umum

1. Buatlah lembar kerja jurnal umum pada sheet-5 seperti gambar diatas

2. Ganti nama Sheet-5 menjadi “Jurnal Umum”

3. Pada lembar kerja jurnal umum buatlah rumus pada kolom akun-1, akun-

2, bantu-1, bantu-2 seperti berikut :

a) Pada Sel B8 ketik rumus = C8 & L8

b) Pada Sel C8 Ketik rumus =COUNTIF(L$8:$L8,L8)

c) Pada Sel D8 Ketik Rumus = E8&M8

d) Pada Sel E8 Ketik Rumus =COUNTIF(M$8:$M8,M8)
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4. Untuk tanggal, bukti, debit dan kredit dilakukan secara manual/ diketik.

5. Sedangkan untuk keterangan rumus yang akan kita pakai adalah

=IF(ISNA(VLOOKUP(L8,DAF_AKUN,2,FALSE)),"",VLOOKUP(L8,

DAF_AKUN,2,FALSE))

Catatan : DAF_AKUN di ambil dari sheet akun dimana sudah di kunci.

Gambar 2.12 Daftar Akun

6. Untuk kode akun dan kode bantu dengan cara buat Drop-Down List Box

( yang berisi daftar kode akun ) pada kolom akun, sehingga ketika akan

mengisi kode akun cukup dengan mengklik drop-down list box tersebut.

Langkah- langkah yang perlu di perhatikan adalah sebagai berikut :

a) Drop-dwon list box harus terhubung dengan lembar kerja Daftar

Akun. Bukalah lembar kerja Daftar Akun, Lalu blok range

kolom kode akun.
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b) kemudian beri nama range untuk kolom kode akun dengan nama

“DAF_AKUN”

c) kembali ke lembar kerja jurnal umum. Blok range kolom kode

akun.

d) Kemudian Klik menu Data →Validation

e) Muncul jendela data Validation berikut :

Gambar 2.12 Data Validation

f) Kemudian Pilih List pada kata allow, dan hilangkan tanda cek

mark (√ ) ignor blank.

g) Dan pada kotak source ketik “DAF_KODE” nama range yang

sudah dibuat pada lembar kerja akun.
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Gambar 2.13 Data Validation

h) Lalu pada tab error Alert, ketikkan pesan error : “Maaf : Kode

Salah” dan klik OK.

Gambar 2.14 Data Validation

i) Liat hasilnya pada lembar kerja jurnal umum, akan nampak list

box kode bantu sebagai berikut :
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Gambar 2.15 : List Box Kode Bantu

j) Isikan data jurnal umum sebagai berikut :

Gambar 2.16 : Jurnal Umum
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2.8.7 Rancangan Format Sheet Buku Besar

Tabel dan format buku besar sebagai berikut :

Gambar 2.17 : Buku Besar

1. Klik Sheet ke 6 lalu ganti nama sheet menjadi “ Buku Besar”

2. Pada Sel D6 isikan kode akun

3. Pada sel D7 isikan nama akun dengan rumus :

=VLOOKUP(D6,DAF_AKUN,2,FALSE)

4. Pada sel H6 isikan pos saldo dengan rumus :

=VLOOKUP(D6,DAF_AKUN,3,FALSE)

5. Pada sel H7 isikan saldo awal dengan rumus :

=VLOOKUP(D6,DAF_AKUN,6,FALSE)+VLOOKUP(D6,DAF_AKUN,

7,FALSE)

6. Pada kolom tanggal isikan denga rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_AKUN2,6,FALSE))=TRUE,

"",VLOOKUP(B10&$D$6,JU_AKUN2,6,FALSE))

7. Pada kolom bukti tinggal isikan rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_AKUN2,7,FALSE))=TRUE,

"",VLOOKUP(B10&$D$6,JU_AKUN2,7,FALSE))

8. Pada keterangan isikan rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_AKUN2,8,FALSE))=TRUE,
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"",VLOOKUP(B10&$D$6,JU_AKUN2,8,FALSE))

9. Pada kolom debit isikan rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_AKUN2,13,FALSE))=TR

UE,"",VLOOKUP(B10&$D$6,JU_AKUN2,13,FALSE))

10. Pada kolom kredit isikan rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_AKUN2,14,FALSE))=TR

UE,"",VLOOKUP(B10&$D$6,JU_AKUN2,14,FALSE))

11. Pada kolom saldo isikan rumus :

=IF(AND(F10="",G10=""),0,IF($H$6="D",$H$7+SUM($F$10:F10)-

SUM($G$10:G10),$H$7-SUM($F$10:F10)+SUM($G$10:G10)))

2.8.8 Rancangan Format Sheet Buku Besar Pembantu

Tabel dan Format Buku Besar Pembantu sebagai berikut :

Gambar 2.18 Buku Besar Pembantu

1. Buatlah lembar kerja Buku Besar Pembantu pada sheet ke 7 , caranya

hampir sama dengan lembar kerja buku besar, sehingga cukup meng-

copy lembar kerja buku besar ke sheet 7, kemudian merubahnya menjadi
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lembar kerja buku besar pembantu.

2. Ubahlah drop-down list box pada sel D6 agar isinya menjadi Daftar kode

pembantu dengan cara :

a) Klik Sel D6

b) Klik menu Data > Validation

c) Setelah muncul jendela Data Validation, Pada kotak Source

yang semula berisi “=AKUN” berubah menjadi “=KODE”

3. Kemudian edit rumus pada sel D7 agar dapat menuliskan data nama

relasi sesuai dengan kode pembantu yang dituliskan pada sel D6.

“DAF_AKUN” menjadi “DAF_KODE”, Sehingga menjadi rumus :

=VLOOKUP(D6,DAF_BANTU,2,FALSE)

a) Kemudian rumus pada sel H6 untuk pos saldo :

=VLOOKUP(D6,DAF_BANTU,3,FALSE)

b) Rumus pada sel H7 untuk Saldo Awal :

=VLOOKUP(D6,DAF_BANTU,4,FALSE)

4. Berikutnya buatlah rumus-rumus pada kolom, tanggal, bukti , keterangan,

debit dan kredit yaitu rumus untuk memindahkan data-data dari jurnal ke

dalam buku besar berdasarkan kriteria akun sebelum membuat rumus

terlebih dahulu bukalah lembar kerja jurnal umum dan buatlah nama

range pada lembar kerja tersebut. Blok kolom D sampai M, kemudian

ketik nama range JU-KODE pada kotak name box. Nama range tersebut

digunakan untuk membantu perumusan pada sel-sel kolom, tanggal,

bukti, keterangan, debit dan kredit lembar kerja buku besar.

5. Mengedit rumus pada kolom tanggal klik C10 dan edit teks rumus
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“JU_AKUN;2” menjadi “JU_KODE;4” sehingga menjadi rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_BANTU,4,FALSE))=TRUE,

"",VLOOKUP(B10&$D$6,JU_BANTU,4,FALSE))

6. Mengedit rumus pada kolom bukti klik sel D10 dan edit teks rumus

“JU_AKUN;7” menjadi “JU_AKUN;5” sehingga menjadi rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_BANTU,5,FALSE))=TRUE,

"",VLOOKUP(B10&$D$6,JU_BANTU,5,FALSE))

7. Mengedit rumus pada kolom keterangan klik sel E10 dan edit teks rumus

“JU_AKUN;2” menjadi “JU_AKUN;6” sehingga menjadi rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_BANTU,6,FALSE))=TRUE,

"",VLOOKUP(B10&$D$6,JU_BANTU,6,FALSE))

8. Mengedit rumus pada kolom debet klik sel F10 dan edit teks rumus

“JU_AKUN;2” menjadi “JU_AKUN;10” sehingga menjadi rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_BANTU,10,FALSE))=TRU

E,"",VLOOKUP(B10&$D$6,JU_BANTU,10,FALSE))

9. Mengedit Rumus pada kolom kredit klik sel G10 dan edit tkes rumus

“JU_AKUN;2” menjadi “JU_AKUN;11” sehingga menjadi rumus :

=IF(ISERROR(VLOOKUP(B10&$D$6,JU_BANTU,11,FALSE))=TRU

E,"",VLOOKUP(B10&$D$6,JU_BANTU,11,FALSE))

10. Mengedit rumus pada kolom saldo klik sel H10 dan edit teks rumus “D”

menjadi “Piutang” sehingga rumusnya menjadi :

=IF(AND(F10="",G10=""),0,IF($H$6="D",$H$7+SUM($F$10:F10)-

SUM($G$10:G10),$H$7-SUM($F$10:F10)+SUM($G$10:G10)))
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2.8.9 Rancangan Format Sheet Neraca Lajur

1. Buat lah lembar kerja Neraca lajur pada sheet 8

Gambar 2.19 Rancangan Format Neraca Lajur

2. Isi Kode Akun

3. Pada kolom Nama Akun isikan dengan rumus :

=VLOOKUP(B10,DAF_AKUN,2,FALSE)

4. Pada kolom pos saldo isikan dengan rumus :

=VLOOKUP(B10,DAF_AKUN,3,FALSE)

5. Pada Kolom neraca saldo untuk debet diisikan dengan rumus :

=IF(D10="D",SUMIF('Daftar Akun'!$B$7:$B$49,'Neraca

Lajur'!B10,'Daftar

Akun'!$G$7:$G$49)+SUMIF(Jurnal!$L$8:$L$783,'Neraca

Lajur'!B10,Jurnal!$N$8:$N$783)-SUMIF(Jurnal!$L$8:$L$783,'Neraca

Lajur'!B10,Jurnal!$O$8:$O$783),0)

6. Pada Kolom neraca saldo untuk kredit diisikan dengan rumus :

=IF(D10="K",SUMIF('Daftar Akun'!$B$7:$B$49,'Neraca

Lajur'!B10,'Daftar Akun'!$H$7:$H$49)-

SUMIF(Jurnal!$L$8:$L$783,'Neraca

Lajur'!B10,Jurnal!$N$8:$N$783)+SUMIF(Jurnal!$L$8:$L$783,'Neraca

Lajur'!B10,Jurnal!$O$8:$O$783),0)
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7. Pada Kolom Pos Laporan isikan dengan rumus :

=VLOOKUP(B10,DAF_AKUN,4,FALSE)

8. Untuk Kolom Laba rugi pada bagian debit isikan dengan rumus :

=IF(G10="L/R",E10,0)

9. Untuk Kolom Laba rugi pada bagian kredit isikan dengan rumus :

=IF(G10="L/R",F10,0)

10. Untuk Kolom Laporan Posisi keuangan bagian debit isikan dengan

rumus :

=IF(G10="LPK",E10,0)

11. Untuk Kolom Laporan Posisi Keuangan bagian kredit isikan dengan

rumus:

=IF(G10="LPK",F10,0)

2.8.10 Rancangan Format Sheet Laba Rugi

Buat tabel dan format seperti gambar dibawah ini :

Gambar 2.20 : Format Laporan Laba Rugi
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Langkah-langkah :

1. Klik Sheet ke 9 lalu ganti nama sheet menjadi “Laporan Laba Rugi”

2. isikan kode akun, kode akun di copy dari kode akun yang terdapat di

sheet akun. Akan tetapi akun yang diambil akun yang terdapat dalam

laporan laba rugi.

3. Untuk nama akun rumus yang digunakan adalah

=VLOOKUP(B7,DAF_AKUN,2,FALSE)

4. Untuk nominal rumus yang digunakan adalah

=SUMIF('NeracaLajur'!$B$8:$B$46,B8,'NeracaLajur'!$H$8:$H$46)+SU

MIF('NeracaLajur'!$B$8:$B$46,B8,'Neraca Lajur'!$I$8:$I$46)

5. Untuk mengisi kolom total pendapatan isikan dengan rumus :

=SUM(D8:D8)

6. Untuk Total laba bersih dengan rumus =E9-E12-E27

2.8.11 Rancangan Format Laporan Posisi Keuangan

Tabel Laporan Posisi Keuangan :

Gambar 2.21 : Laporan Posisi Keuangan
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Langkah-langkah :

1. Buatlah Lembar Kerja Laporan Posisi Keuangan (LPK) pada sheet

10

2. Kode akun di copy dari kode akun yang terdaoat pada sheet akun.

Akan tetaoi akun yang diambil akun yang terdapat dalam laporan

posisi keuangan.

3. Untuk nama akun rumus yang digunakan adalah:

=VLOOKUP(B9,DAF_AKUN,2,FALSE)

4. Sedangkan untuk nominal rumus yang digunakan adalah :

=SUMIF('NeracaLajur'!$B$8:$B$518,'LaporanPosisiKeuangan'!B9,'

NeracaLajur'!$J$8:$J$518)+SUMIF('NeracaLajur'!$B$8:$$518,'Lap

oran Posisi Keuangan'!B9,'Neraca Lajur'!$K$8:$K$518)

5. Untuk mengisi saldo total aset lancar isikan dengan rumus :

=SUM(D9:D17)

6. Begitupun dengan aset tetap gunakan rumus yang sama dengan sel

yang berbeda.

7. untuk total aset lancar dan aset tetap dengan rumus :

=SUM(D18:D23)

8. Begitupun seterusnya sampai ekuitas pemilik

9. untuk total kewajiban +ekuitas isikan dengan rumus :

=SUM(D27:D33)
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